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Hexagon is a global leader in sensor, software and autonomous solutions. We are putting data 
to work to boost efficiency, productivity, and quality across industrial, manufacturing, 
infrastructure, safety, and mobility applications. 

Our technologies are shaping urban and production ecosystems to become increasingly 
connected and autonomous – ensuring a scalable, sustainable future. 

Learn more at Hexagonmi.com. Hexagon’s Manufacturing Intelligence division provides 
solutions that utilise data from design and engineering, production and metrology to make 
manufacturing smarter. 

Learn more about Hexagon (Nasdaq Stockholm: HEXA B) at hexagon.com and follow us 
@HexagonAB. 

  



FTICATIA V5: User Guide 2 
 

Copyright © 2022 Hexagon AB and/or its subsidiaries. All rights reserved. 

 

Disclaimer 

 

This documentation, as well as the software described in it, is furnished under license and may 
be used only in accordance with the terms of such license. 

Hexagon reserves the right to make changes in specifications and other information contained 
in this document without prior notice. 

The concepts, methods, and examples presented in this text are for illustrative and educational 
purposes only, and are not intended to be exhaustive or to apply to any particular engineering 
problem or design. Hexagon assumes no liability or responsibility to any person or company for 
direct or indirect damages resulting from the use of any information contained herein. 

 

Copyright © 2022 Hexagon AB and/or its subsidiaries. All rights reserved. 

 

This notice shall be marked on any reproduction of this documentation, in whole or in part. Any 
reproduction or distribution of this document, in whole or in part, without the prior written 
consent of Hexagon is prohibited. 

This software may contain certain third-party software that is protected by copyright and 
licensed from third party licensors. Additional terms and conditions and/or notices may apply for 
certain third party software.  

Such additional third party software terms and conditions and/or notices may be set forth in 
documentation and/or at http://www.mscsoftware.com/thirdpartysoftware (or successor website 
designated by Hexagon from time to time). Portions of this software are owned by Siemens 
Product Lifecycle Management, Inc. © Copyright 2022 

The Hexagon logo, Hexagon, MSC, MSC Adams, and Adams are trademarks or registered 
trademarks of Hexagon AB and/or its subsidiaries.  FLEXlm and FlexNet Publisher are 
trademarks or registered trademarks of Flexera Software. Parasolid is a registered trademark of 
Siemens Product Lifecycle Management, Inc. All other trademarks are the property of their 
respective owners. 
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Chapter 1: Introduction 

FTICATIA is cost optimization, nesting, and formability simulation software integrated within the 
CATIAV5 environment. The main modules include CATNEST, PROGNEST, CATBLANK, 
CATFORM, CATSTAMP, COST OPTMIZER and COST OPTIMIZER ADVANCED. 

CATNEST: Specifically designed for nesting sheet metal blanks on coils. 

 

PROGNEST: Specifically designed for producing the initial strip layout on coils for progressive 
die forming operations. 

 

CATBLANK:  Specifically designed for blank development and cost estimating. 

 

▪ For process conditions, only CLAMPS, User Defined Restraint and Enforced Displacement are 

available. 

▪ Curved Binder analysis is available, but Tailor Welded Blank analysis is NOT available 

▪ For formability result, only THICKNESS is available. 

CATFORM: Specifically designed for cost estimating and formability analysis. 

 

▪ For process conditions, Draw Bead is NOT available. 

▪ Tailor Welded Blank analysis is available, but Curved Binder analysis is NOT available. 

▪ For formability result, limited forming results are available. 

CATSTAMP: Specifically designed for cost estimating and complete formability analysis with 
complete forming conditions and result plots available. 

 

COST OPTIMIZER: A combination of CATBLANK, CATNEST and Cost Optimization.  

COST OPTIMIZER Advanced: A combination of CATSTAMP, CATNEST and Cost 
Optimization.  
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Chapter 2: Preparing the Model for Analysis 

In this section: 

▪ Preparing the Surface Model 

▪ Hole Filling & Healing 

▪ Features Added in Secondary Operations 

▪ Defining the Material and External View 

Preparing the Surface Model 

The mesher that is used in the FTI analysis tools is designed to mesh native CATIA data.  When 
the geometry is clean (as native geometry usually is), there are almost never any problems with 
mesh generation.  When trying to mesh imported data however, there are sometimes problems. 
These issues are almost universally caused by problems with the geometry. These problems 
include poor surface boundaries, twisted surfaces and overlapping surface edges. 

Preparing Imported Surface Geometry 

When surface data is imported in IGES format, the individual surfaces are not connected.  In 
order to mesh the part, the surfaces must be joined together to form one unit – a continuous 
“quilt” of surfaces. 

There are two functions in CATIAV5 that can help you join the surfaces. The first function is 
called Join. This tool will use the imported surfaces without modification and simply recognizes 
where they should be joined.  Alternatively, the Heal function actually modifies the surfaces in 
an attempt to close gaps. While this function will accept wider tolerances, it sometimes creates 
new problems while fixing others. 

Preparing Surface Geometry from Solid Model 

If you are working with a solid model, a surface model can be created by using the Extract 
function from the Operations toolbar in the Generative Shape Design workbench.  

You can use Top, Bottom, or Middle surface from the solid model for analysis.  You simply must 
ensure that you choose the appropriate thickness direction during analysis setup. 
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Hole Filling and Healing 

 

If holes in the part are pierced in a secondary operation after the forming operation, the holes 
should be removed from the geometry. 

Holes can be filled using CATIA commands such as the Fill command. However for parts that 
contain several holes this can be a time consuming process. The Fill Holes & Heal command 
will help automate the hole filling process.  

The Fill Holes & Heal command will automatically fill in all holes that are smaller than a user 
defined value in the selected geometry with a CATIA Fill surface. The user has the option to 
choose Fill or Heal.  

The Heal function is designed to help clean up imported or V4 data. It uses specialized 
algorithms to automatically eliminate duplicate surfaces, repair bad surfaces and correct 
topology issues. The healing function may modify the base surfaces so it should only be used 
for preparing a model for analysis. You can perform healing on a single surface body or on 
multiple surface entities.  

 

The Fill Holes & Heal command is found in the FTI Forming Tools workbench. Select Start > 
Mechanical Design > FTI Forming Tools. It is also a toolbar that can be added to the 
Generative Shape Design (GSD) workbench. 

Some holes cannot be filled with a single surface. This often occurs when the boundary is too 
complex (such as on very large holes) or discontinuous. This aspect of the Hole Filling function 
actually proves very useful in identifying issues with the CATIA geometry since it will show you 
which holes could not be filled and therefore may contain discontinuous geometry. 

If any of the Fill features fail, a warning will be shown in the specifications tree and the feature 
will not be created. If you expand the Fill object in the specifications tree, it will contain a 
Boundary object. You can select the Boundary object and then select Reframe On in the 
contextual menu to find this boundary.  

Features Added in Secondary Operations 

Any features added in secondary operations should be removed using CATIAV5 base 
functionality.  These features include, but are not limited to, holes, notches, extrusions, and 
hems. 
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Defining the Material and External View 

Although FTICATIA products do not utilize the properties of the material assigned to the part 
model, all of CATIA’s analysis tools require that a material be assigned to the model prior to 
beginning an analysis. This requirement translates to FTICATIA products as well. 

To assign a material to your model, select the Apply Material icon from the Apply Material 
toolbar in the Generative Shape Design workbench. 

 

The dialog shown at left will appear. Select a material and select the geometry to which you 
want to apply the material. The easiest way to do this is to select the Part1 item at the top of the 
feature tree. This will apply the material to the entire model. 

 

If you apply a material that has the same name as a material in the FTI material database, then 
you will not have to apply the material again in the analysis.  We have provided another material 
catalog with all of the materials in our database.  It can be found in C:\FTI\FTICATIAV5Rxx and 
is named FTICatalog.CATMaterial. 

The final step in preparing your model for analysis is defining the External View. The external 
view determines what subset of geometry from your model will be analyzed.  

 

For example, if you created a solid model and extracted a mid-surface, you would assign the 
mid-surface to the external view. To create an external view, select External View from the 
Tools menu in the workbench. The dialog shown at left will appear. Select the geometry from 
the model and press OK.  
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Chapter 3: Setting Up the Analysis 

In this section: 

▪ Starting the Analysis 

▪ Defining the Material 

▪ Defining the Mesh Parameters 

▪ Curved Binder 

▪ Setting the Material Thickness 

▪ Tipping and Symmetry 

▪ Forming Process 

▪ Friction and Blankholder Force 

▪ Pressure Pads 

▪ Draw Beads 

▪ Target Strain  

▪ Clamps 

▪ User Defined Restraint 

▪ Enforced displacement 

▪ Solving 
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Starting the Analysis 

When you have completed the steps outlined in Chapter 2 and you are ready to start your 
analysis, select FTI Forming Analysis from the Analysis and Simulation section of the CATIA 
Start menu. 

 

A dialog will appear prompting the user to select an analysis case. Available options may vary 
according to the license held by the user. Selecting the highest level option (CATSTAMP) will 
give you the most functionality and complexity whereas the lower level options (CATBLANK) will 
provide a simpler interface requiring fewer inputs but with less flexibility and power.  

Note: It is recommended that the Keep as default starting analysis case option is not selected. 
When this option is selected the initial part mesh settings are typically not suitable for forming 
analysis and will need to be modified before the part mesh is generated. 

After selecting an analysis case, a new Analysis workbench will be created and a new category 
called Finite Element Model.1 will be added to the tree (see below). Under this branch will be 
entries for the mesh, inputs and the CATSTAMP (CATFORM or CATBLANK) Forming 
Solution Set where the result plots will be stored. 

Note: If part of the analysis tree is missing, it is likely that you are experiencing licensing 
problems.  You may be missing the license, using the wrong license or all of the licenses (on a 
network license) may currently be checked out. 
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Defining the Material 

Because the standard CATIA material library does not support the material properties required 
to run a forming analysis, the material must be re-defined in the analysis workbench.  This also 
enables us to model different materials in different areas of the part to represent a tailor welded 
blank. 

To define a material, select the Material Selection icon from the Forming toolbar (see below). 

 

Select a material from the list. Check the values below to ensure that they are correct. 
Sometimes, these properties will vary from supplier to supplier. 

 

 Important! If you are using any material other than steel (ex. aluminum), make sure you 
enter in an FLD0 value near the bottom of the dialog. This value will be calculated from the 
other material properties if it is set to zero, however the calculation is only valid for ferrous 
metals (steel, iron, etc). The FLD0 value determines the point at which the material will fail so it 
is critical to obtaining useful analysis results. 

At the bottom of the dialog, you can optionally load a stress strain curve for the material. This 
will typically improve results for materials with unique stress/strain relationships (ex. dual phase 
steel, etc.). 
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If the part will be made from a tailor welded blank, assign one material for each section of the 
part. 

The units for the stress-strain curve are psi for stress and true (decimal) for strain.  The stress-
strain curve files are text files (.txt) with the extensions renamed to .ssc.  The format of the files 
is two columns, with strain in the first and stress in the second.  The values are separated by a 
space.  

The units for the forming limit curve are engineering %.  The forming limit curve files are text 
files (.txt) with the extensions renamed to .flc.  The format of the files is two columns with minor 
strain in the first and major strain in the second.  The values should be separated by one or 
more spaces.  
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Defining the Mesh Parameters 

In this manual we will cover mesh generation using CATIA’s Octree Triangle Mesher tools.  If 
you have the license for the Advanced Meshing Tools workbench, you can also use that to 
generate your mesh however the Octree Triangle Mesher is simpler to use and usually yields 
more than adequate results. 

When an analysis is created, the mesh part will automatically be assigned to the part defined 
using the External View command (see Section 2.8). You can change the mesh size settings by 
double clicking on the green triangle on the part or by editing the definition of the Part Mesh 
entry in the tree (located under Nodes and Elements). 

 

The dialog will appear with default values in the three text boxes. 

▪ The Size value determines the maximum size of mesh element that will be created. This 

value should typically lie in the range of 10 to 50mm. 

▪ The Absolute Sag value determines the allowable deviation from the true geometry. In 

areas where the geometry is curved, the elements (which are all flat) will not deviate from 

the true curve more than this value (see below). If the deviation is higher, the mesh will be 

automatically broken down (refined) into more, smaller elements during the meshing 

process.  This value should typically be set between 0.1 to 0.5mm. 

▪ Proportional Sag is the ratio between the local absolute sag and the local mesh edge length. 

The default value is 0.2 

 

 

NOTE:  The most constraining of the Absolute Sag and Proportional Sag values will be used 
during mesh generation. 
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A good mesh will typically have at least three elements on the critical radii (below left). Fewer 
elements (below right) will not simulate the material flow as accurately.  If this is the case, try 
using a smaller sag value to create more elements.  Notice that large elements are just as 
effective at modeling flat areas as smaller elements. 

 

If you have licensing for the advanced meshing tools, you can reduce the minimum element size 
by changing the minimum size for sag specs on the last tab (Others) in the meshing dialog 
(shown below). 

 

NOTE:  Using a smaller size or sag value will create more mesh elements in your model. 
Increasing the number of mesh elements will increase the time required to solve the part. Care 
should be taken to ensure that an excessive number of mesh elements is not used. 
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Curved Binder  

By default, the FTICATIA analysis is performed with a default flat binder.  In many cases, the 
actual forming starts with a curved binder that creates a curved blank.  The curved blank usually 
results in more material being available for the forming operation.  This extra material has a 
significant effect on the results depending on the forming conditions that were applied.  

To run a curved binder analysis you must have a surface representing the binder geometry.  
The binder shape must be developable and must be large enough to contain the developed 
blank shape for the model. A developable binder is defined as one that has been bent into a 
simple curve in such a way that if it were flattened, there would be little or no residual strain in 
the blank. A separate mesh must be created for the curved binder geometry.  

To create a mesh for the curved binder select the Octree Triangular Mesher icon from the 
forming toolbar and select the curved binder geometry. When meshing this binder, the mesh 
does not have to relate to the mesh size of the part. 

 

 Important!:  Curved Binder function is not available with CATFORM  
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Setting the Material Thickness 

The next step in the analysis procedure is to set the material thickness.  Because the model 
being analyzed is a surface model with effectively zero thickness, the thickness must be set 
prior to analysis. 

When you start an analysis, a default thickness values and direction is automatically assigned to 
the model. This thickness value can be seen as a number highlighted on top of the geometry. 

To change the material thickness value, double click on the number or edit the definition of 2D 
Property.1 in the tree under Properties.1. 

 

The thickness dialog will appear. Change the thickness value to the correct thickness. 

Note: to ensure that the thickness value is being used by the analysis corresponds to the 
thickness value in the model; it is a good idea to use a formula to link the thickness value with 
the part geometry. 

To change thickness direction, double click on the arrow sign or edit the definition of Thickness 
Direction in the tree under Restraint Set.  

 

If you are conducting an analysis on a part made with a tailor welded blank, select one 
material type for each segment of the part using the Material Selection icon (even if two 
segments are the same material, there must be two definitions). The first material and the 
default thickness value will automatically be assigned to the whole model. To assign additional 
materials and thicknesses to different regions on the part, press the Material Thickness icon 
(see below) from the Forming toolbar. 

 

Select the area of the part to assign the second material and thickness to and enter the 
thickness. Repeat this procedure until a thickness has been assigned to all regions of the 
model. 
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 NOTE:  You can only assign the second thickness when you have a CATFORM or 
CATSTAMP license 
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Tipping and Symmetry 

Most CATIA models are constructed in the assembly position.  This is usually not the position 
the part will be formed in.  For this reason, we must define the press direction prior to running 
the analysis. 

To set the press direction (or “tip” the part), select the Tipping & Symmetry icon (see below) 
from the Forming toolbar. 

 

If you do not know the forming direction and you want the software to automatically determine 
an approximate orientation, check the Auto Tipping check box and close the dialog. 

 

Alternatively, you can create a line or a planar surface in your part model which can be used to 
set the press direction. Click on the line or the planar surface and close the dialog. 

Symmetry 

Sometimes it is desirable to model only half of a part to speed up model creation and solution 
time.  FTICATIA has the ability to model only half of a symmetrical part by applying a symmetry 
condition that will model the part as if the other half was also present. 

To apply symmetry, create a plane in the part model that represents the plane of symmetry. 
Then, in the tipping and symmetry dialog, select the plane. After defining the symmetry plane 
you must also define the tip direction using either a line or planar surface. You can also apply a 
second symmetry plane to model only a quarter of a part. 

Undercut 

To display the elements which are undercut, select the Display Undercut button.  The model will 
need to be meshed prior to display of the undercut elements.  If there are undercut areas in the 
model, use the tipping functions to try to eliminate the undercut areas as much as possible. 

  



FTICATIA V5: User Guide 20 
 

Copyright © 2022 Hexagon AB and/or its subsidiaries. All rights reserved. 

 

Forming Process 

This option allows you to input the type of process that you are using to manufacture the part.  
This will influence the way the part deforms during forming and can affect the blank shape.  You 
can choose between a Draw Die and a Form Die. 

The forming process is set to Draw Die by default.  If you want to change between the Draw Die 
and the Form Die process, double click on the Forming Process branch in the Specification 
Tree to open the dialog is shown below: 

 

Draw Die 

If you are forming a part using a draw die (illustrated below left) you should use the Draw Die 
forming process.  

As material passes over the radius on the die, additional strain is added to the part due to the 
friction between the part and the die and the bending and unbending process. These additional 
strains are not present when a part is manufactured using a form die.  

The friction and bending effects are automatically considered by FormingSuite when the Draw 
Die setting is turned on.  The Draw Die process formulation determines the areas of curvature 
on the part and adds the required forces and strains to any material that would flow over them 
during forming. 

 



FTICATIA V5: User Guide 21 
 

Copyright © 2022 Hexagon AB and/or its subsidiaries. All rights reserved. 

 

Form Die 

If you are forming a part using a Form Die (illustrated below right) you should use the Form Die 
forming process. This process is typically used in progressive dies and simple flanging 
operations. 

In this type of operation, the blank material is not pulled through a radius; it is simply bent 
around it. As a result, there are no additional strains produced by friction. 
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Friction and Blankholder Force 

CATFORM and CATSTAMP have the ability to simulate the effects of a uniformly distributed 
blankholder force.  It does this by applying a uniform edge tension to the boundary of the part 
during simulation.  This will lead to additional stretch in the model and will help reduce wrinkling. 

Additionally, you can modify the friction coefficient used during the analysis to simulate special 
lubricants or coatings. 

To apply a blankholder force to your part, select the Friction and Blank Holder icon (see 
below) from the Process Condition toolbar. 

 

 

To apply a blankholder force, specify a value for the force in the BHF text box. 1 is used to 
simulate a low holding force, 2 is medium, 3 is high and 4 will lock the edges of the part so it is 
formed as pure stretch. The actual forces that correspond with these settings vary based on the 
material properties. You can also set the blankholder force to a specific value by putting a 5 in 
the BHF text box and entering the force in the User Defined Blank Holder Force text box. 

You can apply local blankholder forces using the Variable Blank Holder icon in the Process 
Condition toolbar. 

 

Select lines/curves on the edge(s) of the part to apply the blankholder to and specify the force. 
You can add multiple unique blankholder forces in different areas.  

NOTE:  Blankholder Force functions are not available with CATBLANK 
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Pressure Pads 

CATFORM and CATSTAMP can also simulate the effects of one or more pressure pads that 
may be applied to the part during forming.  It does this by restraining the movement of the mesh 
elements in the area under the pad. 

To apply a pressure pad to your part, select the Pressure Pad icon (see below) from the 
Process Condition toolbar. 

 

 

To apply a pressure pad, select the face(s) to constrain from the part model. The entire surface 
of the selected face(s) will be constrained by the simulated pad.  If you want to apply the pad to 
only part of the face, split the face using the CATIA geometry tools. 

After selecting the faces, specify a value for the pad pressure in the Pad Pressure text box.  
Note that this is the pressure the pad is exerting on the part and not the cylinder pressure. 

Tip: It is generally best to run the first analysis on a part with no pressure pads or blankholder 
force since adding these forces increases the stretch.  If a part splits with no forces, it will almost 
certainly split if they are added.  

 NOTE:  Pressure Pads function is not available with CATBLANK. 
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Draw Beads 

This forming condition can be used to simulate the control of material flow into the die cavity 
using a draw bead or a lock bead. 

To apply a draw bead to your part, select the Draw Bead icon (see below) from the Process 
Condition toolbar. 

 

 

To apply a draw bead, select the geometry representing the location (Supports) and specify a 
value for the Draw Bead Force. Geometry from a sketch cannot be selected. Geometry on a 
sketch must first be projected on to the part before it can be used to define the location of a 
draw bead. All other splines, polylines, lines and arcs can be used.  

 NOTE:  Draw Bead function is only available for CATSTAMP. 
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Target Strain 

Target Strain is used when analyzing class ‘A’ product geometry (without flanges/hems or 
addendum) to simulate an ideal dieface design that would deliver a defined strain pattern at a 
specified location.  It may not be possible to design physical tooling that will yield the same 
results, therefore Target Strain results should be reviewed with this in mind. 

To apply Target Strain to your part, select the Target Strain icon (see below) from the Process 
Condition toolbar. 

 

 

To apply Target Strain to a part, select the point on the geometry representing the desired target 
strain location (Target Point).  

Select the point of first Contact where the punch first touches the blank (Reference Point). This 
step is optional; it is only necessary if the Point of First Contact is different than the Target Point.  

Input both Major and Minor strains (Target Major Strain & Target Minor Strain) in percent 
engineering strain.  

Check the Principal Strain Direction checkbox to specify the major strain direction as an angle 
(in degrees) measured from the x-axis of the axis system used for tipping. This step is optional. 
It is helpful to define the tip direction using a coordinate system rather than using either auto-
tipping or a single axis die line since a tip direction defined by a coordinate system defines a 
clear x-axis for the AutoStrain calculations. Using auto-tipping or a single axis die line does not 
explicitly define x-axis; this may produce unexpected results. 
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Clamps 

All FTICATIA analysis products allow the user to fix the position of a face, edge or point on the 
X-Y plane between the blank and part by defining a clamp.   

To apply a clamp to your part, select the Clamp icon (see below) from the Process Condition 
toolbar. 

 

 

To apply a clamp, select a face, edge and/or vertex of the part geometry representing the 
location (Supports) for the clamp. 
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User Defined Restraint 

All FTICATIA analysis products allow the user to fix any combination of available nodal degree 
of freedom on a face, edge or point by defining a User Defined Restraint.  There are three 
translation degrees of freedom and three rotation degrees of freedom that could be restrained 

To apply a User Defined Restraint to your part, select the User Defined Restraint icon (see 
below) from the Process Condition toolbar. 

 

 

To apply a user defined restraint, select a face, edge and/or vertex of the part geometry 
representing the location (Supports) for the user defined restraint. 
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Enforced Displacement 

Enforced Displacements are loads applied to support geometries, resulting for the subsequent 
analysis in assigning non-zero values to displacements in previously restrained directions.  

Enforced Displacement objects belong to Loads objects sets. An Enforced Displacement object 
is by definition associated to a Restraint object. 

Make sure you entered non-zero values only for those degrees of freedom which have been 
fixed by the associated Restraint object. Non-zero values for any other degree of freedom will 
be ignored by the program 

To apply an Enforced Displacements to your part, select the Enforced Displacement icon (see 
below) from the Process Condition toolbar. 

 

 

To apply an enforced displacement, select the restraint previously defined by User defined 
restraint, and then apply a non-zero number to the directions defined by User Defined Restraint. 
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Friction 

The friction coefficient used in the analysis is set in the Friction object in the Restraint Set in the 
feature tree.  This object is automatically created when you create an analysis. The default 
value of 0.15 represents a typical, conservative value for mill oil on steel. You can change this 
value to a lower value when a lubricant is being used or when tooling has special, anti-friction 
coatings. Conversely, it can be helpful to raise the value slightly when forming aluminum or 
increasing it substantially (up to 0.3) for simulating hot forming. 

Solving 

When the model set up is complete, the final step before viewing the results is meshing and 
solving. In CATIAV5, this is combined into one step. 

Select the Mesh & Compute icon (see below) from the Forming toolbar. 

 

To start the analysis, set the drop-down box to All and press OK. This will first mesh the part 
and then run the solver.  To generate the mesh without solving set the option to Mesh Only and 
press OK. 

 

Meshing will typically take a few seconds to a couple of minutes. The solving process could take 
just a few seconds to several minutes for a complex part. 

On occasion, the mesh will fail. This may be caused by problems with the geometry.  The 
problem can often be overcome by simply changing to a slightly different mesh size and re-
running the solution. 

Once you have generated results, any changes to the input geometry or analysis setup will 
cause the solver and the mesher (if required) to re-run when you try to re-activate a result plot. 
This update mechanism ensures that the analysis results are always consistent with the current 
model. 
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Chapter 4: Viewing Results 

In this section: 

▪ Generating a Result 

▪ Results 

▪ Forming Limit Diagram 

▪ Create Blank Face Feature 

▪ Point Mapping 

▪ Part Weight Calculator 

▪ Re-Running the Analysis After Changing the Inputs 

▪ Multiple Forming Cases 

▪ Typical Analysis Methodology 
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Generating a Result 

FTICATIA provides a comprehensive set of graphical results plots along with a punch force 
calculation and several blank shape generation tools. These results can be used to quickly find 
hot spots, create cost estimates and create an in depth formability analysis of the part. 

Select the Forming Solution Set from the feature tree to specify the analysis for which you want 
to generate a result plot. Then, select the desired result plot icon from the forming toolbar (see 
below). 

 

▪ Part and Blank 

▪ 3D and 2D Displacement  

▪ X, Y and Z Displacement  

 

 
▪ Create Blank Face 

▪ Point Mapping 

▪ Part Weight 

 

▪ Safety Zones 

▪ Safety Margin 

▪ Forming Zones 

 
▪ Major Strain 

▪ Minor Strain 

▪ Equivalent Strain 

▪ Equivalent Stress 

 
▪ Thickness 

▪ Thickness Strain 

 
▪ Punch Force 

 
▪ Export Results 

 
▪ Basis Analysis Report 

 

NOTE:  When viewing multiple result plots, make sure you deactivate (not hide) all the result 
plots other than the current one. Otherwise, the results will overlap on the screen. You may also 
have to hide the mesh (Nodes and Elements) and the original geometry (Links Manager) in 
order to view the result plots clearly.  



FTICATIA V5: User Guide 32 
 

Copyright © 2022 Hexagon AB and/or its subsidiaries. All rights reserved. 

 

Results 

Blank Shape 

 

The blank shape plot displays the blank (deformed mesh) on the screen underneath (or over) the part 

mesh. Since CATSTAMP simulates the forming in reverse (i.e. from the part to the blank) the deformed 

mesh will be the flat pattern for the part. 

Forming Displacement 

 

Displays the various displacement components as calculated between the part and blank. 

Direction Description 

3D The total node displacement between the part and blank.  The 
square root of the X displacement squared plus the Y displacement 
squared plus the Z displacement squared. 

2D Nodal displacement between the part and the blank in the X-Y plane. 

X Node displacement in the X direction between the part and blank. 

Y Node displacement in the Y direction between the part and blank. 

Z Node displacement in the Z direction between the part and blank. 

 

NOTE:  Forming Displacement plots are only available for CATSTAMP 

Create Blank Face 

 

To convert the blank to an associative surface select the Create Blank Face icon from the Forming 

toolbar. 

Point Mapping 

 

To map a point from the part to the blank shape, select the Point Mapping icon on the Forming toolbar. 
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Part Weight 

 

To calculate the part weight, accounting for the change in material thickness during the forming 

operation, select Part Weight. You will be prompted to select the geometry to calculate the part weight 

for. The geometry selected does not have to be the geometry defined as the external view for the 

analysis. 

Safety Zone 

 

The safety zone plot shows whether or not a part will be formable. It is a qualitative plot (shows trends, 

not numbers). Each color represents a different zone. These zones are described in the table below: 

Value Zone Description 

0-1 Strong Wrinkling 
Tendency 

Material is gathering and thickening. Stresses are in 
compression in all in-plane directions. If the material is 
unsupported, it will likely wrinkle in this area. 

1-2 Mild Wrinkling 
Tendency 

Material is gathering and thickening somewhat. Stresses 
are in compression in the minor strain direction. 
Wrinkling may occur in this area. 

2-3 Safe Material will not split or wrinkle but thinning could be 
higher than desirable. 

3-4 Marginal The part is very close to splitting in this area. Any 
problems with the process will create a split. If all things 
are perfect, the part may form. 

4-5 Failure The part is being stretched too much and will split in this 
area unless special considerations are made during 
tooling design. 

 

NOTE:  Safety Zone function is not available for CATBLANK 

  



FTICATIA V5: User Guide 34 
 

Copyright © 2022 Hexagon AB and/or its subsidiaries. All rights reserved. 

 

Safety Margin 

 

Displays the relative strain between the FLC and major strain value at each node. 

▪ S = 1, the major strain of the nodal point is 0 

▪ S > 0, the nodal point is below the FLC and may be safe 

▪ S = 0, the nodal point lies on the FLC 

 

 

NOTE: Safety Margin function is only available for CATSTAMP 
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Forming Zone 

 

The Forming Zone plot describes the state of stretch in the part. It is a qualitative plot (shows trends, not 

numbers). Each color represents a different zone. These zones are described in the table below: 

Value Zone Description 

0-1 Strong Wrinkling 
Tendency 

Material is gathering and thickening. Stresses are in 
compression in all in-plane directions. If the material is 
unsupported, it will likely wrinkle in this area. 

1-2 Mild Wrinkling 
Tendency 

Material is gathering and thickening somewhat. Stresses 
are in compression in the minor strain direction. 
Wrinkling may occur in this area. 

2-3 Loose Material Material is unsupported and could lead to poor surface 
effects such as oil canning. 

3-4 Semi-Tight Panel Material is being stretched but minor strain is negative. 

4-5 Plane Strain Material is experiencing stretch in only major strain 
direction. 

5-6 Tight Panel Material is being stretched in both major strain and 
minor strain directions. This leads to good stiffness and 
dent resistance but may also cause high thinning. 

NOTE:  Forming Zone function is not available for CATBLANK 

Major Strain 

 

The major strain is measured at each node on the mesh (each corner of each element). It is 
defined as the strain (% stretch) in whatever direction has the greatest in-plane stretch. 

NOTE:  Major Strain function is not available for CATBLANK 

Minor Strain 

 

The minor strain is the strain in the in-plane direction perpendicular to the direction of the major 
strain. 

NOTE:  Minor Strain function is not available for CATBLANK.  
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Equivalent Strain 

 

The hypothetical strain representing the sum of the Thickness, Major and Minor strains values in 
a uniaxial tension test. 

NOTE:  Equivalent Strain function is only available for CATSTAMP  

Equivalent Stress 

 

The hypothetical stress required to deform the material by the equivalent strain amount in a 
uniaxial tension test. 

NOTE:  Equivalent Stress function is only available for CATSTAMP 

Thickness 

 

This plot shows the actual material thickness after the forming operation.  

Thickness Strain 

 

This plot shows the percent change in material thickness resulting from the forming process. It 
is often easier to interpret than the Thickness plot since determining the change does not 
depend on the original thickness of the blanks. 

NOTE:  Thickness Strain function is not available for CATBLANK. 

Punch Force 

 

Displays the force required to deform the material. 

NOTE:  Punch Force function is only available for CATSTAMP. 

Export Results 

 

Export thickness and strain results for downstream CAE applications as a Nastran or LS-DYNA 
file.  

NOTE:  Exporting Results function is not available for CATBLANK. 
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Displaying Results for Top, Mid, or Bottom Surfaces 

By default, all results are shown for the mid-plane of the model.  Certain result plots, namely; 
Safety Margin, Major Strain, Minor Strain, Equivalent Strain, and Equivalent Stress can be 
configured to display top, middle, or bottom results.  The remaining result plots will only display 
the mid-plane results. 

To change whether you are displaying top, middle, or bottom results, you must right-click on the 
result plot from the specification tree and select definition from the menu to open the Image 
Edition dialog (shown below).  Once the dialog is open expand it by selecting the More button, 
then select the drop down menu for Layer and choose either upper, mid, or lower. 
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Basic Analysis Report 

 

Create an HTML based report summarizing the formability analysis. 

Important Note: When viewing results, always make sure you are using the Custom view mode 
with the Material option turned on. Otherwise, most results will not appear correctly. You can 
modify the render style by selecting Render Style from the View menu and selecting Customize 
View from the sub-menu.  

TIP:  To hide the curved binder geometry in a plot, edit the definition of the plot and turn on the 
part geometry filter. To edit the definition of the plot, right click on the result plot in the 
Specifications tree and select <result plot name> object -> Definition. 

 

Then on the Selections tab click on Part Mesh and select OK. 
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FTI Forming Reports 

Once you have completed your formability analysis, you can export a report. 

To create a CATSTAMP report 

1. On the feature tree, right-click on FTICATSTAMP and then click FTICATSTAMP Object 
> Report. 
 

 
 

2. Click to select any Formability plots that you want to include in the report. 

3. Click Forming Limit Diagram to include an FLD plot. 

4. Click Min/Max Info to include custom min and max points in the report. 

5. Click OK to generate the report. 
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Forming Limit Diagram 

The strain distribution for all the nodes on the part can be displayed on a Forming Limit Diagram 
(FLD).  The FLD can be used to determine the forming mode and the formability of the part in a 
local area. 

 

To display the FLD result, select the Forming Limit Diagram icon on the Forming toolbar. 

 

TIP:  If additional material types or thickness have been defined for a Tailor Welded Blank then 
separate FLD's will be created for each material. Click the numbered tabs on the right-hand side 
of the Forming Limit Diagram window to display the selected FLD and edit its options. 

The diagram and safety limits for the FLD can be changed from the Options tab.  Change any 
field then return to the Diagram tab, the settings will be applied and the FLD updated 
automatically. 
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Diagram Limits 

The default Major and Minor Strain axis limits are determined from the maximum and minimum 
major and minor strains. To change the axis limits enter a new value in the desired field. 

Note: Closing and reopening the FLD will restore the default axis limits. 

FLD0 

FLD0 is the major strain value where the forming limit curve crosses the major strain axis (minor 
strain equals zero). There are two possible default settings for FLD0, if FLD0 is defined as a 
material property (non-zero value) then this value is used. Otherwise, if it is set to zero as a 
material property the FLD0 will be calculated from the n-value and material thickness. To 
change the default FLD0 enter a new value into the FLD0 field. 

Low Strain Zone 

A Low Strain zone can be defined for the Safety Zone plot. The Low Strain zone is a circular 
area centered on the origin of the Forming Limit Diagram (0% major and minor strain). The 
default value is 0.25. 

Thinning and Shear Limits 

Thinning and Shear Limits can be defined for the Safety Zone plot. The red line on the right-
hand side of the plot is the Thinning Limit Line. The red line on the left-hand side represents the 
Shear Limit Line. The default values are 23 and 65 for Thinning and Shear respectively. 

Thinning and Shear Margins 

Thinning and Shear Margins can be defined for the Safety Zone plot. The yellow line on the 
right-hand side of the plot is the Thinning Margin Line. The yellow line on the left-hand side 
represents the Shear Margin Line. The default values are 2.3 and 6.5 for Thinning and Shear 
respectively, 10% of the limit values. 

Plane Strain Margin 

The default Plane Strain Margin defining the plane strain zone is set to the area on the FLD 
where the minor strain is 5% of the major strain. To change this margin, change the setting in 
the Plane Strain Margin field. 

Safety Margin 

The default Safety Margin defining the marginal splitting zone is set to the area between the 
Forming Limit Curve and the safety curve, which is offset below by 10%. To change this offset, 
change the setting in the Safety Margin field. 

NOTE: A safety margin of 10% is typical for steels. For Aluminum a typical safety margin is 6 to 
7% The Forming Limit Diagram is not available for CATBLANK 

  



FTICATIA V5: User Guide 43 
 

Copyright © 2022 Hexagon AB and/or its subsidiaries. All rights reserved. 

 

Create Blank Face Feature 

To create the blank face geometry, select the Create Blank Face Feature icon from the blank 
face toolbar.  This will open the dialog, which will contain various options depending on the type 
of analysis run. 

 

 

If you ran a curved binder analysis, you will have the option to create the blank on the binder 
surface as well.  If you select the location on binder, you will only be able to select the outline 
option for geometry type. 

If the part geometry in the analysis contained any holes, you will have the option to create the 
blank with or without these holes included. 

The smoothing parameters allow you to choose how you would like to smooth the blank 
boundary.  You choose from Line & Arc, B-Spline, Line, and None.  If you choose Line and Arc, 
you will need to specify the tolerance, min. arc radius, and the max. angle.  The smoothing type 
none, refers to leaving the boundary of the blank to be made up of the boundary mesh element 
edges. 

The option to Create Blank Feature allows for associatively between the blank face feature and 
the analysis.  If this option is un-checked, then any changes to the analysis after the blank is 
created will not be reflected in the blank geometry. 
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Point Mapping 

The purpose of this function is to provide a tool that allows you to map points, lines, and edges 
from the part model to the blank and vice versa. 

To map entities from the part to the blank open the point mapping function after solving, select 
the entities that you would like to map, and click OK.  To map entities from the blank to the part, 
you will need to check the Map To Part option. 

 

 

If you performed an analysis using a curved binder, you will also have the option to Map To 
Binder. 
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Part Weight Calculator 

The purpose of this function is to provide a very accurate part weight that considers the 
following: 

▪ Thinning and thickening that occurs during the forming process, & 

▪ Holes that are removed after forming the part 

This function is meant to replace the current practice of basing the weight on the volume of a 
uniform thickness solid model, which typically leads to over-estimates of part weight. 

To display the value in the specification tree, you must choose to display the value under 
Options > General > Parameters and Measure as well as Options > Analysis & Simulation > 
General. 

Procedure: 

1. A forming analysis is performed on a version of the part geometry with holes filled and 
possibly addendum added.  This is generally the draw geometry. 

2. The blank shape is calculated from the above forming analysis. 

3. You then select the model of the part to use for mapping/trimming and hole removal.  
You will first need to show the final part geometry in the GSD workbench and hide the 
draw geometry. 

4. Open the Part Weight Calculator and select the final part geometry. 
 

 

 

5. Thickness and mapping information is taken from the current solution set 

6. A new blank is created in the feature tree – it is made up of an outline (created by 
mapping the part boundary to the analysis blank), a filled surface (to create the new 
blank face), another mapping and a join (to define the holes) and a split to remove the 
holes from the blank face 

7. The weight will be calculated from the surface area of the split and is displayed as a 
parameter on the Specifications Tree in the Analysis Workbench. 
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Re-Running the Analysis after Changing the Inputs 

If you make changes to any of the analysis inputs that will affect the results (ex. geometry, mesh 
size, material, etc.) all result plots will be deactivated. When you reactivate a result plot, you will 
be warned that the analysis results are out of date and you will be asked if you want to proceed. 
Clicking yes will re-mesh the model if necessary and re-run the solution with the new input 
values. When the solution is complete, the result plots can then be viewed again. 

This parametric link between the solution and all the inputs will prevent any user from viewing 
data that is no longer valid due to a change implemented between the first time the analysis was 
run and the point when the user reopens the result for viewing. 

Multiple Forming Cases 

Multiple Forming Cases can be analyzed at once to compare the effects of different settings on 
the analysis results. Unique tipping positions and forming constraints can be applied to each 
forming case.  

Select Forming Case from the Insert menu to add a second forming case. 

Each forming case will be listed as a unique branch in the Specifications tree. The active 
forming case will be underlined. To view the results from the non-active forming case, right click 
on the forming case and select Set As Current Case. 

Typical Analysis Methodology 

When analyzing product geometry, the main concern is identifying potential formability issues. 
This usually involves a qualitative approach which means that the numerical results are of less 
importance than the trends. There are a number of variables that can be changed in the tool to 
influence the strain values but geometrical problems such as radii and wrinkling are more 
difficult to remedy. To identify these problems, start by analyzing the part with no blankholder 
force.  

If the part splits inside the part, you will need to change the geometry or material. A split on the 
part edge may be remedied by adding extra material during forming and trimming later so this is 
not as significant. Increasing the blankholder force at this point would simply exaggerate the 
splitting problem. 

If the part does not exhibit any splitting or excess thinning but does show some wrinkling, 
increase the blankholder force (one step at a time) and re-run the analysis. If the new results 
show splitting and wrinkling is still a problem, some geometry changes may be required. If there 
are still no splits and the wrinkling problem has been solved, the part should be ready for 
manufacturing. 
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Chapter 5: Formability Analysis Tools 

FTI CATSTAMP enables you to access new formability analysis tools. These include: 

Forming Analysis icon ( ) 

Blank Development icon ( ) 

Springback Analysis icon ( ) 

 

To access formability analysis tools 

1. On the Main Menu, click View and then Toolbars. 

2. Ensure that Formability Analysis Tools is enabled with a checkmark. 

You can now access Formability Analysis icons on the CATIA toolbar. 
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Forming Analysis 

The FTI Forming Analysis dialog enables you to configure material properties, process, constraints, 

forming conditions, as well as other parameters. You can configure each tab independently, entering 

parameters, or leaving each blank.  

Important  It is recommended that you configure all required tabs before clicking OK. Clicking OK solves 

the forming analysis based on your input parameters, and creates a part geometry mesh that is added to 

the feature tree and named FTICATSTAMP. 

This enables you to view formability results for the mesh. Click here to learn about viewing formability 

results. 

To access the FTI Forming Analysis dialog 

1. On the Formability Analysis Tool menu, click the Forming Analysis icon ( ). 
 

 

2. Click on your Part Geometry to select a part and enable the forming analysis tabs. 

  

https://hexmet-my.sharepoint.com/personal/matthew_calmes_hexagon_com/Documents/Documents/mcalmes/CATIA%20V5%20Docs/Old/FTICATIA_V5_UserGuide_rev2_mcalmes.docx#ViewingFormabilityResults
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The Material Tab 

The Material tab enables you to select or modify material and thickness parameters for your part 
geometry. 

To configure the material tab 

1. On the FTI Forming Analysis dialog, click the Material tab. 
 

 
 

2. Next to Material Type, select a material from the drop-down menu. 

3. Enter a Thickness in mm or use the arrows to increase or decrease the material 
thickness. 

4. Enter a Friction value.  
 
Note  Friction is applied to areas where the material is being drawn through a radius in a 
draw die, and is also used by forming conditions such as a Pressure Pad. This value 
defines the friction between the tooling and the blank material. 

5. Under Thickness Direction, select from the following: 

Middle: Split the thickness and assume the value of the material thickness exists on both sides. 

Side 1: Choose the side that the material represents, and the direction of the material. 

Side 2 

 

Note  Thickness direction refers to the preferential grain direction of a material. This gives 

each material unique properties related to r-value and other material properties. 

6. Click OK to close.  
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The Process Tab 

The Process tab enables you to set the press direction as well as select a forming process. 

To configure process 

1. On the FTI Forming Analysis dialog, click the Process tab. 

2. In the field next to Press Direction, click in the graphics display area to select a press 
direction. 
 

 
 

3. Under Process, select from the following: 

Draw: A draw die is a specific form of die that wraps a flat sheet of metal around the punch 

while holding the workpiece around the cavity to control metal flow. 
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Form: A form Die is typically used in progressive dies and simple flanging operations. In this type 

of operation, the blank material is not pulled through a radius; it is simply bent around it. As 

a result, there are no additional strains produced by friction. 

 

 

4. Under Press Direction, select from the following: 

▪ Auto: CATIA automatically calculates the press direction. Select from the 
following methods: 

▪ Average Normal: The vector generated will be an average of the normal 
to all surfaces. 

▪ Minimize Undercut: The vector generated considers all angles on the 
part that could cause undercut and generates a vector that is less than 
180 degrees to as many surfaces as possible. 

▪ Minimize Depth: The vector generated will minimize the draw depth of all 
surfaces. 
 

▪ Reverse Direction: Click to reverse the press direction. 
 

5. Under Manual Rotation,  click the X, Y, and Z icons to rotate the press direction. You 
can also enter a Rotational Increment. 

6. Under Display, select the following: 

▪ Undercut: Displays areas that cannot be formed with an initial punch operation. 
These areas include flanges that must be created by a cam after the initial punch 
operation that curve under the initial stroke. 

▪ Draft Angle: Displays areas of the geometry set that allow for smooth ejection 
from the die. 

▪ Draw Depth 

  



FTICATIA V5: User Guide 52 
 

Copyright © 2022 Hexagon AB and/or its subsidiaries. All rights reserved. 

 

The Constraints Tab 

The Constraints tab enables you to constrain elements of your part geometry. You can select several 
different elements such as: 

Edges: Any element that is a border to a face or surface. 

Faces: Any surface of the part geometry. 

Lines: Any line that has been added to the part geometry to serve as a trim line or draw bead 

line. 

Points: Any vertex on the part geometry. 

To configure constraints 

1. On the FTI Forming Analysis dialog, click the Constraints tab. 
 

 
 

2. Under Elements to Constrain, click no selection. 

3. Click on the geometry set to select an element. 
 
Note  To remove a selected element, click Remove Mode and then click the element to 
remove it from the list. 
 

4. Click OK to apply the forming constraints. 
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The Conditions Tab 

The Conditions tab enables you to apply forming conditions to your part geometry. You can apply 
forming conditions to: 

Edges: Any element that is a border to a face or surface. 

Faces: Any surface of the part geometry. 

Lines: Any line that has been added to the part geometry to serve as a trim line or draw bead 

line. 

Points: Any vertex on the part geometry. 

To configure forming conditions 

1. On the FTI Forming Analysis dialog, click the Conditions tab. 
 

 
 

2. Select a forming condition Type drop-down menu: 

Blankholder: The blankholder is the upper and lower holding surfaces which control metal flow 

around a shape to be formed in a draw operation. 

Tension: Tension is the internal force or forces within a body. These forces can cause the 

extension or stretching of a material 

Draw Beads: A draw bead is a ridge constructed around a portion of a die cavity to control metal 

flow. A groove is added to the mating blank holder to allow clearance for the draw bead and 

die closing. 

Pressure Pad:  The pressure bad controls the movement of material in the local area, and is 

simulated by restraining the movement of the mesh elements in the area under the pad. 

3. Select a level of Magnitude from the drop-down menu: 

Low 

Medium 
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High 

4. Enter a force Value, or use the arrows to increase or decrease the force value. 

5. Click Add to add the forming condition to the Forming Conditions list.  
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The Mesh Tab 

The Mesh tab enables you to select mesh generation settings for your part geometry. 

To configure mesh settings 

1. On the FTI Forming Analysis dialog, click the Mesh tab. 
 

 
 

2. Under Mesh Settings, select from the following: 

Good 

Better 

Best 

Custom: Selecting custom enables you to manually enter Chord Deviation and Maximum 

Element Size for the mesh. 

 

 

3. Click OK to save settings.  



FTICATIA V5: User Guide 56 
 

Copyright © 2022 Hexagon AB and/or its subsidiaries. All rights reserved. 

 

The KPR Tab 

The Key Product Requirements (KPR) tab enables you to configure and apply a target stains to your 
geometry set. The KPR tab configures the following parameters: 

Target Point: This is the point where the designated target strains are to be achieved.  The point 

is selected by left clicking on the part surface. 

Contact Point: This is the point where the part first contacts the binder wrap surface during the 

forming process.  The point is selected by left clicking on the part surface.  

Major and Minor Strains: The target strain values to be achieved. The strain values must be 

greater than or equal to zero. 

Angle: The orientation of the major strain axis relative to the part geometry is shown by the 

arrow located at the selected Contact Point. 

Note  If you configure KPR parameters, you cannot configure DFM parameters. 

To configure KPR 

1. On the FTI Forming Analysis dialog, click the KPR tab. 
 

 
 

2. Click the field next to Target Point, then click to select a target point on your geometry 
set. 

3. Click the field next to Contact Point, then click to select a contact point on your 
geometry set. 

4. Enter a Major Strain and Minor Strain value, or use the arrows to increase or decrease 
the value. 

5. Enter an Angle for the target strain in degrees, or use the arrows to increase or 
decrease the value. 

6. Click OK to save and close.  
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The DFM Tab 

The Design for Manufacture (DFM) tab enables you to manually configure solution increments for Auto 
Blankholder Force. The blankholder is the upper and lower holding surfaces which control metal flow 
around a shape to be formed in a draw operation. Auto Blankholder Force runs multiple analyses with 
different blankholder forces to produce various outputs and find a good compromise between thinning 
and wrinkling. 

Note  If you increase solution increments to any value greater than 1, the KPR tab is disabled. 

To configure the DFM tab 

1. On the FTI Forming Analysis dialog, click the DFM tab. 
 

 
 

2. Enter a Solution Increments value. Solution Increments set the number of solutions 
provided in post processing. 

3. Click OK to save and close.  
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Viewing Formability Results 

Once you have configured and applied all Formability Analysis tools and created a FTICASTAMP branch 

in the feature tree, you can view formability results such as Safety Zones, or Forming Limit Diagrams 

(FLD) for the geometry set. 

 

Note  Each time that you conduct a Formability Analysis on a Geometrical Set, a new branch named FTI 

CATSTAMP is added to the Feature Tree. This enables you to view formability results for multiple 

forming processes. 

To view formability results 

1. On the Feature Tree, right-click on FTICATSTAMP and then select FTICATSTAMP 
object > Display Results. 
 

 
 

2. In the Display Results Type drop-down menu, click to select a formability result. 
 
Note  Depending on the results type selected, you can enable Smooth Display to 
smooth contours of the results plot. 
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The following results are available for your review: 

▪ Deformed Mesh: Displays deformations in the mesh of the part after forming. 

▪ Safety Zones: Demonstrates if a part is formable by displaying qualitative color areas 

ranging from Safe to Split. 

▪ Forming Zones: Describes the state of stretch in the part. It is a qualitative plot and each 

color represents a different zone. Each zone produces a different panel quality and 

characteristic. The forming zones can be used to identify the strain state of the panel. 

▪ Safety Margins: Displays the relative strain between the Forming Limit Curve (FLC) and the 

major strain value at each node. 

▪ Thickness Strain: Displays the change in thickness of material due to forming. A negative 

value indicates that the part is thinning out. Severe thinning may indicate splitting and 

thickening may indicate wrinkling (especially in thin materials). 

▪ Thickness: Displays the change in thickness of the material due to forming, shown as 

thinning and thickening in millimeters (mm). 

▪ Major Strain: Displays the largest principal strain in the sheet surface. It is often measured 

from the major axis of the eclipse resulting from the deformation of a circular grid. 

▪ Minor Strain: Displays the principle strain in the sheet surface in the direction perpendicular 

to the major strain. 

▪ Equivalent Strain: Displays the hypothetical strain representing the sum of the Thickness, 

Major, and Minor strain values in a uniaxial tension test. 

▪ Equivalent Stress: Displays the hypothetical stress required to deform the material by the 

equivalent strain amount in a uniaxial tension test. 

▪ Displacements: Displays displacements between the part and blank. 

▪ Displacements 2D: Displays the node displacement along the XY plane between the part 

and blank. 

▪ Displacements X: Displays displacements in the X direction only. 

▪ Displacements Y: Displays displacements in the Y direction only. 

▪ Displacements Z: Displays displacements in the Z direction only. 

Depending on the results you choose to display, you can click to enable and open Display FLD, 
which will open a separate Forming Limit Diagram window. You also can access the following 
options: 

▪ Enable Pick Info: Click a point on the geometrical set to show specific display results for that 

point. 

▪ Enable Multi Pick: Click multiple points on the geometrical set to show display results for 

that point. 
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▪ Display Min/Max Results Info: Display the Minimum and Maximum values on the 

geometrical set, based on your initial pick info point. 
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Viewing the Forming Limit Diagram (FLD) 

In addition to viewing Formability plots, you can also view a Forming Limit Diagram (FLD) based on your 

formability analysis. Formability describes whether the part is safe or will have areas with a tendency to 

split or wrinkle. The FLD is a map of the strain state of a model. The strains of each node are plotted 

onto the major and minor strain axes. The position of each point on the FLD can be used to determine 

what forming mode and the formability of the part in a local area.  

To view the FLD 

1. On the Feature Tree, right-click on FTICATSTAMP and then select FTICATSTAMP 
object > Display FLD. 

 

2. Click the Center icon ( ) to reposition the FLD plot to the center axis. 

3. Click Capture Image to save the FLD plot as a JPEG (.jpg) file. 

4. Click OK to close. 
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Options Tab 

You can also configure parameters for your FLD including Diagram Limits and Safety Limits. 

To configure FLD options 

1. On the Forming Limit Diagram dialog, click the Options Tab. 
 

 

2. Under Diagram Limits, configure the following: 

Major Strain:  Enter the lowest and highest limits for the largest principal strain. 

Minor Strain: Enter the lowest and highest limits to the principle strain in the sheet surface in 

the direction perpendicular to the major strain. 

3. Under Safety Limits, configure the following: 

FLD0:  Enter the maximum amount of strain allowed one direction when there is no strain in the 

transverse direction. It is shown as the intersection of the Forming Limit Curve (FLC) and the 

major strain axis on a Forming Limit Diagram (FLD). 

Wrinkle Limit: Enter a value to limit the area appearing to the left of the Major Strain line on the 

FLD. 

Thinning Limit: Enter a value to limit the thinning line. 

Thinning Margin: Enter a value to change the position of the yellow line on the lower left side of 

the plot. 

Shear Limit: Enter a custom offset for marginal splitting zones. 

Shear Margin: Enter a value to change the position of the yellow line on the top left side of the 

plot. 
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Plane Strain Margin: Enter a custom value to change the minor strain percentage of the major 

strain and define the plane strain zone.  

Safety Margin: Enter a value to define the marginal splitting zones. 

4. Click Apply to save and OK to close. 
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Blank Development 

Once you have configured and run Formability analysis, you can use Blank Development to create and 

configure a blank. 

To create and configure a blank 

1. On the Formability Analysis Tool menu, click the Blank Development icon ( ). 
 

 
 

2. On the Feature Tree, click to select FTICATSAMP. This enters the information in the 
Forming Analysis field. 

3. Under Location, select from the following: 

On Flat: Creates a flat blank on the plane perpendicular to the tipping direction. 

On Binder: Creates a blank outline projected onto the binder surface.  

 

Note  Setting the location to On Binder means that only outline is available and not surface. 

4. Under Geometry Type, select from the following: 

Surface: Creates the blank as a surface. 

Wireframe: Creates the blank as an outline. 

5. Under Holes, select from the following: 

With Holes: Creates a blank to include any unfilled holes. 

Without Holes: Creates a blank but removes any unfilled holes. 
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6. Under Parameters, configure the following: 

Method: Click the drop-down menu to select: 

o  BSpline: Creates the blank boundary as a bspline with no tolerance, and uses the 

nodes on the boundary to create the blank. 

o Line: Creates the blank boundary using only lines. 

o Lines and Arcs: Creates the blank boundary by fitting lines and arcs based on the 

specified tolerance.  

Tolerance + : Configure the maximum tolerances for lines, or lines and arcs. 

Tolerance – : Configure the minimum tolerance for lines, or lines and arcs. 

Min. Arc Radius: Enter minimum arc radius size before a corner is created instead of an arc. 

Max. Angle: The maximum arc angle determines at what point a line will be created instead of 

an arc. 

Under Entity Mapping: 

Type: Select from the following: 

▪ Mapping: Map features of the geometry such as points or edges onto the blank. 

▪ Part Weight: Calculate the weight of a specific part. This is useful when trying to 

understand the differences in part weights between parts with or without holes for 

example. 

Features To Map: Click no selection and then click the geometry set to select a feature to map. 

7. Click to enable Map To Part. 

8. If you are using a Binder, you can click to enable Use Binder. 

9. Click OK to save and close. 
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Springback Analysis 

Springback analysis enables you to select a completed forming analysis and display springback in the 

material. Springback, also known as Elastic Recovery, occurs when forces of forming are released and 

the blank "springs back" from elastic deformation. This is important to understand because it can affect 

the final dimensions of the part. 

A blank undergoes plastic and elastic deformation during forming. Plastic deformation occurs when 

there is a permanent stretch in the blank material as it is formed. Elastic deformation is a deformation 

that is not permanent.  

To access the FTI Springback Analysis dialog 

1. On the Formability Analysis Tool menu, click the Springback Analysis icon ( ). 
 

 

2. On the Feature Tree, click to select FTICATSAMP. This enters the information in the 
Forming Analysis field. 
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The Constraints Tab 

The Constraints tab enables you to select elements on your geometry set and constrain them to reduce 

springback. 

To configure springback constraints 

1. On the FTI Springback Analysis dialog, click the Constraints tab. 
 

 
 

2. Under Elements to Constrain, click no selection. 

3. Click on the geometry set to select an element. 
 
Note  To remove a selected element, click Remove Mode and then click the element to 
remove it from the list. 

4. Click OK to apply the springback constraints. 
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The Alignment Tab 

The Alignment tab enables you to select elements to align to on your geometry set. 

To configure alignment 

1. On the FTI Springback Analysis dialog, click the Alignment tab. 
 

 
 

2. Under Elements to Constrain, click no selection. 

3. Click on the geometry set to select an element. 
 
Note  To remove a selected element, click Remove Mode and then click the element to 
remove it from the list. 
 

4. Click OK to align to the selected elements. 
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The Trimming Tab 

The Trimming tab enables you to select an Outer Trim Line and multiple Inner Trim Lines to trim. 

To configure trimming 

1. On the FTI Springback Analysis dialog, click the Trimming tab. 
 

 
 

2. Under Outer Trim Line, click no selection, and then click on the geometry set to select 
an outer trim line. 

3. Under Inner Trim Lines, click no selection, and then click on the geometry set to select 
one or more inner trim lines. 
 
Note  To remove a selected element, click Remove Mode and then click the element to 
remove it from the list. 
 

4. Click OK to select trim lines and close. 

  



FTICATIA V5: User Guide 70 
 

Copyright © 2022 Hexagon AB and/or its subsidiaries. All rights reserved. 

 

Chapter 6: Springback 

In this section: 

▪ Springback  

▪ Springback Analysis 

▪ Process Conditions 

▪ Springback Alignment 

▪ Springback Fixity 

▪ Springback Trimming 

▪ Forming Displacement 

▪ Reflect Lines 
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Springback 

When sheet metal is formed, it undergoes two types of deformation: plastic and elastic. The 
plastic deformation permanently deforms the material. When the part is removed from the die 
and the forming forces are taken away, the elastic deformation will be unloaded and the part will 
experience springback. 

The type of material used in forming has a significant impact on springback. Higher stresses are 
required to form stronger materials which will produce more elastic recovery. Different materials 
(e.g. aluminum) have different elastic modulus values that will also change the springback. 

Although it is often neglected, springback can have an important effect on the resulting part 
shape. A large amount of springback will make it difficult to control the final dimensions of the 
part. 

The springback solver determines the shape of a formed part after it has been released from the 
tool and the elastic recovery of the part (springback) has occurred. 
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Springback Analysis 

To analyze a part’s springback in CATSTAMP, select Springback Case from the Insert menu. 

 

You will be prompted to select an analysis case in the FTI Analysis Case dialog box. Select the 

appropriate Forming Solution Set from the feature tree. The springback results will be calculated based 

on the forming analysis results from the selected solution set. 

 

 

While the CATSPRINGBACK Case is activated, the CATSTAMP Forming Solution Set will be deactivated 

until the CATSTAMP Forming Solution Set is selected once again as the current case. 
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Process Conditions 

To input various process conditions open the Process Condition toolbar on the Forming 
Toolbar and select from the following choices: 

 

Springback Alignment aligns the deformed mesh results with reference geometry. 

 

 

Springback Fixity simulates a clamped condition around the outer boundary of the part. 

 

 

Springback Trimming removes surface faces from the CATSTAMP analysis geometry before 
running springback analysis. 

 

 

Clamp simulates a clamped condition for specified CAD geometry. Refer to section 3.12 on pg. 
23 for more information.  
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Springback Alignment 

To apply Springback Alignment to the part geometry open the Process Condition toolbar and 
select Springback Alignment. For best results, create points on the original part geometry at 
the desired alignment locations. In the alignment dialog, select the desired points. This will align 
the part with the corresponding locations on the deformed mesh using a best-fit approach. 

 

Springback Fixity 

The Springback Fixity tool is used to analyze parts that will be secured to another panel 
around their entire boundary; such as hemmed outer skin panels. Open the Process 
Conditions toolbar and select Springback Fixity to turn on the entire outer boundary fixity 
during springback. This will constrain the springback solution such that the boundary of the part 
does not deflect. This function is very useful for identifying the potential for surface distortion on 
visible panels. 
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Springback Trimming 

The springback exhibited by a part after forming will change when material (such as large holes 
or addendum) is trimmed off Springback Trimming is used to correctly simulate this scenario.  
Open the Process Conditions toolbar and select Springback Trimming. Select an object from 
the feature tree that includes all of the surfaces to be kept after trimming. Note that this object 
must be a parent of the external view. 

 

Springback Results Plots 

Displays the various displacement components as calculated between the part and blank.   

 

Direction Description 

Deformed Mesh 
This result will display the mesh of part after springback. It provides a 
convenient way of overlaying the springback result with the original 
part. 

3D 

The total node displacement between the designed part and the part 
experiencing springback. The square root of the X displacement 
squared plus the Y displacement squared plus the Z displacement 
squared. 

2D 
Node displacement between the designed part and the part 
experiencing springback in the X-Y plane. The square root of the X 
displacement squared plus the Y displacement squared. 

X 
Node displacement in the X direction between the designed part and 
the part experiencing springback. 

Y 
Node displacement in the Y direction between the designed part and 
the part experiencing springback. 

Z 
Node displacement in the Z direction between the designed part and 
the part experiencing springback. 
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Notes:  

▪ You can use the animate button on the Analysis Tools toolbar to animate the deformed 

mesh plot.  

▪ The Deformation Scale Factor tool on the same toolbar can be used to magnify the 

springback effect for visibility. 

▪ When showing the deformed mesh plot, it is helpful to show the part geometry as a basis 

for comparison. 
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Reflect lines 

Reflect Lines are an important way of measuring Class ‘A’ panel surface quality. They are a 
direct measurement of what the customer will see when they view the completed vehicle. 

In practice, Reflect Lines are the reflection of a straight light source off the curved three 
dimensional surface of the panel. 

The Reflect Line viewer shows a series of reflect lines on the panel. The blank lines represent 
the reflect lines based on the original part geometry (before springback) and the red lines 
represent the reflect lines on the geometry after springback. Areas where these two lines 
diverge indicates areas of high distortion. 

Select the Reflect Line icon on the Forming Toolbar to open the viewer as a separate window. 
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As with physical panels, the reflect lines should be viewed from multiple vantage points. This 
highlights each part feature with the light source angle that best displays the surface quality. 
Different light source locations can be shown in the viewer by rotating the part to the desired 
angle and then clicking the Apply button. The part can then be rotated to examine the reflect 
lines of any part area. The light source will not be changed until the apply button is selected. 

The relative scale between the ideal reflect lines (shown in black) and the stamped part reflect 
lines (shown in red) can be adjusted with the displacement scale value option. Changing the 
scale can highlight the subtler deviations for easier analysis. 

Notes: 

▪ To properly display the results in the Reflect Line viewer, the High (Alpha Blending) option 

must be selected for the Transparency Quality setting in Tools->Options->Display-

>Performance. 

▪ The Displacement Scale Value will increase magnitude of the difference in the springback 

lines versus the theoretical designs for easier spotting of problem areas. 

▪ The reflect lines are created on the finite element mesh. In areas of low mesh density, this 

may result in jagged reflect lines. Refining the mesh will improve the quality of the reflect 

line display in such cases. 

Export 

While working on a Springback case, the Export icon will allow you to export the springback 
data in a variety of formats: 

▪ NASTRAN (.nas or .dat): exporting in NASTRAN format will produce a file containing the 

“sprung” mesh (after springback) 

▪ LS-Dyna (.dyn):  this option will export an LS-Dyna model file containing the sprung mesh 

▪ Text (.txt): this option will export a text file containing the nodal displacements occurring 

during springback. This file can then be used by the CATIA RSO module for morphing the 

geometry to compensate for springback. 

▪ STL File (.stl) 
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Chapter 6: Nesting Layout 

In this section: 

▪ Displaying Parameters  

▪ Defining Cost Parameters 

▪ Defining Material 

▪ Nesting Parameters 

▪ Viewing Nesting Layout Results 

▪ Viewing Other Nesting Layout Results 

▪ Layout Editing 

▪ Associative and Regenerative Layout 
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Displaying Parameters 

CATNEST uses parameters to input layout and cost parameters. In the Options window located 
under the Tools menu, the following options must be set to properly utilize CATNEST. 

Turn on the display of Parameters in the Specification Tree.  

 

Turn on the display of the Parameters Value in the Specification Tree. 
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Defining Cost Parameters 

To set up the nesting calculation, some parameters need to be defined. These are entered 
under the Parameters branch of the Specifications Tree. 

 

You can specify cost parameters by clicking the Cost Parameters icon on Nesting toolbar and 
key in the value in the Cost Parameters dialog. 

 

NOTE:  By default, the Thickness cost parameter is read from the part geometry. If part 
thickness is defined using thin parts attribute, shell entity or thick surface, the thickness value 
will show up automatically. This parameter is not linked to the analysis workbench directly, so 
the analysis thickness will not used by the cost parameters. 

  



FTICATIA V5: User Guide 83 
 

Copyright © 2022 Hexagon AB and/or its subsidiaries. All rights reserved. 

 

Thickness: part model material thickness 

Base Material Cost: fixed cost of the material per weight unit 

Variable Material Cost: cost specified by coil thickness and width 

Extra Material Cost: any other material costs measured per unit weight of material. e.g., 
lubricants, coatings, handling, etc. 

Scrap Cost: the value of the scrap material 

Consumables: any additional costs that cannot be measured in $/kg. e.g., electricity, labor, etc. 

Production Volume: the annual number of blanks that will be produced or the total number of 
blanks on a program basis. 

DieCostPerLength1: represents the cost of the die based on the perimeter of the blank shape 
for one-up nesting layouts. 

DieCostPerLength2: represents the cost of the die based on the perimeter of the blank shape 
for two-up nesting layouts. 

TotalDieCost1: the overall value of the die expressed in the current currency for one-up nesting 
layouts. 

TotalDieCost2: overall value of the die expressed in the current currency for two-up nesting 
layouts. 

Cut-Off Die Cost: overall value of the cut-off die expressed in the current currency  

Currency: the current currency 

NOTE: The cost parameters can also be modified by double clicking on the parameter name 
located under the Parameters branch of the Specifications Tree. 
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Variable Material Cost 

The additional costing parameters are imported as a table.  The imported table specifies the 
material price per kilogram, depending on sheet thickness and coil width.  If a table is imported 
the Base Cost is grayed out. 

Creation of the table can be done using a predefined Excel template.  This will ensure that 
exported ASCII data will always be consistent.  The table should be exported in either .txt or 
.csv format. 

Format of the Table 

The entry in the first column/row should generally be defined as 0.  It specifies the cost 
parameters for the range from 0 to the next value or from the value in the first column/row to the 
next value. 

If the parameter appears for which the thickness/width range is not defined, then the resulting 
cost will be 0. 

The specified price applies to the range between the specified value and the next specified 
value, i.e. 86 applies to thickness between >0.6 and <=0.7 and a coil width of <= 750 for the 
table shown below. 

The value in the last column/row is taken for the thickness/width higher than the specified value, 
i.e. coil width is 2000mm and thickness is 0.75, base cost value is 72 for the table below.  For 
1mm thickness and 2000mm width, 71 is applied for the table below. 

If the calculated width is less than the smallest width in the table then the cost will be zero by 
definition. 

 

The thickness and width must be specified in mm.  The cost value is specified as $/kg.  The 
currency type is taken from the Cost Parameters.  If no currency is defined, then USD will be 
used as the default. 
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Importing a Variable Material Cost Table 

To import a variable material cost table open the Cost Parameters dialog, select the import icon, 
and select the text and csv file to be imported. 

 

To view the table after import, select the view icon.  Notice that the units have been added to 
the table and the Base Material Cost has been grayed out. 

 

To remove the Variable Material Cost table, select the remove icon. 
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Defining Material 

CATNEST uses the properties of the material assigned to calculate the gross weight of the part 
model.  

To assign a material to your model, select the Apply Material icon from the Apply Material 
toolbar. 

 

The Library dialog below will appear. Select a material and select the geometry to which you 
want to apply the material. The easiest way to do this is to select the Part1 item at the top of the 
feature tree. This will apply the material to the entire model.  
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Nesting Parameters 

To set up the nesting calculation, some parameters need to be defined. These are entered in 
the Nesting Parameters dialog box. To open the Nesting Parameters dialog box select the 
Compute Nesting Layout icon on the Nesting toolbar. 

 

An FTIBlankNesting.1 branch is added to the Specifications Tree and the Nesting Parameters 
dialog box opens when the Compute Nesting Layout icon is selected. 

 

Select the blank surface (First Blank) to define the geometry to be used in the nesting layout. 
For a Two Blanks nesting layout a Second Blank must also be defined. 

On the Layout Style tab of the Nesting Parameters dialog box specify the nesting layouts to be 
calculated. 
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Layout constraints can be defined on the other tabs in the Nesting Parameters dialog box. Once 
all the nesting parameters have been defined select the OK button to start the nesting layout 
calculation. 

You can also specify the Dist. Between Blanks and Blank to Coil Edge parameters. The Dist. 
Between Blanks is the minimum distance between the nested blanks. The Blank to Coil Edge is 
the minimum distance between the nested blanks and the edge of the coil. 

 

If the width of the coil is known prior to nesting, this information can be added as a constraint on 
the Width Constraints tab of the Nesting Parameters dialog box. If a Variable Width constraint 
is added, only the nesting layouts that fall within the minimum and maximum values will be 
calculated. If a Fixed Width is defined, only nesting layouts with the fixed width value will be 
calculated. Defining an Automatic constraint will calculate the coil width for the lowest cost. The 
maximum coil width is defined as 72 inches or 1828.8 mm. This value can be overwritten by 
keying in a different value in the Max. Width: field. 
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Pitch refers to the relative distance between the blank shapes. If the pitch of the nesting layout 
is known prior to nesting, this information can be added as a constraint on the Pitch 
Constraints tab of the Nesting Parameters dialog box. If a maximum pitch constraint is added, 
only the nesting layouts with a pitch equal to or less than the specified value will be calculated.  

 

To control how the first blank is rotated on the coil an angle constraint can be defined on the 
Layout Angle Constraints tab of the Nesting Parameters dialog box. If a Variable Layout 
Angle constraint is added, only the nesting layouts that fall within the minimum and maximum 
values will be calculated. If a Fixed Layout Angle is defined, only nesting layouts with the fixed 
layout angle value will be calculated. Defining an Automatic constraint will calculate the layout 
angle for the lowest cost. 
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To control how the second blank is rotated on the coil an angle constraint can be defined on the 
Relative Layout Angle Constraints tab of the Nesting Parameters dialog box. If a Variable 
Relative Angle constraint is added, only the nesting layouts that fall within the minimum and 
maximum values will be calculated. If a Fixed Relative Angle is defined, only nesting layouts 
with the fixed relative angle value will be calculated. Defining an Automatic constraint will 
calculate the relative angle for the lowest cost. Defining a Relative Angle Constraint only is 
useful for Two Up, Mirror and/or Two Blank layouts. 
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Layout constraints can be defined on the other tabs in the Nesting Parameters dialog box. Once 
all the nesting parameters have been defined select the OK button to start the nesting layout 
calculation. 

You can also specify the Dist. Between Blanks and Blank to Coil Edge parameters. The Dist. 
Between Blanks is the minimum distance between the nested blanks. The Blank to Coil Edge is 
the minimum distance between the nested blanks and the edge of the coil. 
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If the width of the coil is known prior to nesting, this information can be added as a constraint on 
the Width Constraints tab of the Nesting Parameters dialog box. If a Variable Width constraint 
is added, only the nesting layouts that fall within the minimum and maximum values will be 
calculated. If a Fixed Width is defined, only nesting layouts with the fixed width value will be 
calculated. Defining an Automatic constraint will calculate the coil width for the lowest cost. The 
maximum coil width is defined as 72 inches or 1828.8 mm. This value can be overwritten by 
keying in a different value in the Max. Width: field. 

 

Pitch refers to the relative distance between the blank shapes. If the pitch of the nesting layout 
is known prior to nesting, this information can be added as a constraint on the Pitch 
Constraints tab of the Nesting Parameters dialog box. If a maximum pitch constraint is added, 
only the nesting layouts with a pitch equal to or less than the specified value will be calculated. 
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To control how the first blank is rotated on the coil an angle constraint can be defined on the 
Layout Angle Constraints tab of the Nesting Parameters dialog box. If a Variable Layout Angle 
constraint is added, only the nesting layouts that fall within the minimum and maximum values 
will be calculated. If a Fixed Layout Angle is defined, only nesting layouts with the fixed layout 
angle value will be calculated. Defining an Automatic constraint will calculate the layout angle 
for the lowest cost.  

 

To control how the second blank is rotated on the coil an angle constraint can be defined on the 
Relative Layout Angle Constraints tab of the Nesting Parameters dialog box. If a Variable 
Relative Angle constraint is added, only the nesting layouts that fall within the minimum and 
maximum values will be calculated. If a Fixed Relative Angle is defined, only nesting layouts 
with the fixed relative angle value will be calculated. Defining an Automatic constraint will 
calculate the relative angle for the lowest cost. Defining a Relative Angle Constraint only is 
useful for Two Up, Mirror and/or Two Blank layouts. 
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Viewing Nesting Layout Results 

Once the nesting layout calculation is complete the nesting layout with the highest material 
utilization will be displayed on the X-Y plane and the corresponding result parameters will be 
listed under the Blank Nesting.1 branch. 

 

MatUtilization: (material utilization) % of the material that is used by the blank  

Pitch: calculated relative distance between the blanks 

Width: calculated coil width 

BlankingCost: represents the cost of each blank based on the Base Material Cost, Extra 
Material Cost, Scrap Value, Consumables, Gross Weight, and Net Weight. 

DieCost: represents the cost of the die per blank 
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Viewing Other Nesting Layout Results 

Additional layout results can be viewed in the Results Table. To open the Results Table, right 
click on the FTIBlankNesting.1 branch and select Table Results. 

 

To view other layout results, double click on the row for that result in the Results Table.  

<Line#> is the currently displayed layout. Columns can be sorted by selecting the column 
header.  

Nesting Report 

When the result is highlighted in the table results, the Report button will become active.  Select 
Report, choose the format of the report, either HTML or Excel based, name the report and 
select Save. 

The report will automatically open once created.  When selecting the Excel based report you 
may need to enable the macros to view all the data, or reduce your security settings in Excel. 

 

NOTE: In order to show images on the HTML report, you must turn on Activate local 
visualization on the General tab under Tools-Options-Infrastructure-Part Infrastructure. 
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Layout Editing 

The nesting layout can be manually manipulated to test any changes or adjustments to the 
automatically generated nest.  Using this feature, changes in blank shape and its effects on 
nesting results can be tested by overlapping the blanks.  

To optimize the blank, right click on the FTIBlankNesting.1 branch and select Layout Editing. 
The Layout Editing dialog box will open. There are three areas in the Layout Editing dialog 
box: Cluster To Be Edited, Edit Blanks and Edit Coil Edges. 

For One Up layouts the Cluster To Be Edited area is not displayed in the Layout Editing dialog 
box. 

 

Cluster To Be Edited 

Side: When side is chosen, the two blanks on the right will be moved as a group.   

Top: When top is chosen, the blanks on the top will be moved as a group.   

Bottom: When bottom is chosen, the blanks on the bottom will be moved as a group. 
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Edit Blanks 

Translation - The blanks can be moved right or left (+/- X direction) by defining an increment of 
movement and selecting the –X and +X buttons. The blanks can be moved up or down (+/- Y 
direction) by defining an increment of movement and selecting the –Y and +Y buttons. The +Y/-
Y buttons are not visible if the side cluster has been selected. 

Rotation - The blanks can be rotated in the counterclockwise (ccw) or clockwise (cw) direction 
by choosing the increment of rotation (degrees) and selecting the appropriate button.  

Edit Coil Edges 

The top and/or bottom coil edge can be moved up or down (+/- Y direction) by defining an 
increment of movement and selecting the –Y and +Y buttons. If both the top and bottom coil 
edges are selected the +/-Y and -/+Y buttons will be available to move the coil edges at the 
same time in opposite directions. 

Notes: Clicking on the Reset button will return the blanks to the original nest. The parameters 
under the Blank Nesting.1 branch associatively update as  the nesting layout is modified in the 
Layout Editing dialog box. 
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Associative and Regenerative Layout 

If you make changes to the nesting layout inputs that affect the results (e.g., geometry, part to 
edge distance, layout angle, etc.), the results stored under the FTIBlankNesting.1 branch will be 
recalculated.  

This associative link between the solution and all the inputs will prevent any user from viewing 
data that is no longer valid due to a change implemented between the first time the analysis was 
run and the point when the user reopens the result for viewing. 
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Chapter 7: ProgNest 

In this section: 

▪ Progressive Nesting (ProgNest) Parameters 

▪ Layout Style 

▪ Layout Angle Constraints 

▪ Width Constraints 

▪ Progression Constraints 

▪ Relative Angle Constraints 

▪ Layout Editing 

▪ Report Generation 

  



FTICATIA V5: User Guide 100 
 

Copyright © 2022 Hexagon AB and/or its subsidiaries. All rights reserved. 

 

Progressive Nesting Parameters 

ProgNest is specifically designed for producing the initial strip layout for progressive die forming 
operations. For the progressive nesting calculation, some parameters need to be defined. 
These are entered into the ProgNest Parameters dialog box. To open the ProgNest Parameters 
dialog box select the Compute ProgNest Layouts icon on the Nesting toolbar. 

 

An FTIProgNest.1 branch is added to the Specifications Tree and the ProgNest Parameters 
dialog box opens when the Compute ProgNest Layouts icon is selected. 

 

Select the blank surface (Blank Geometry) to define the geometry to be used in the ProgNest 
layout.  
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Layout Style 

On the Layout Style tab of the ProgNest Parameters dialog box specify the Progressive Nesting layout to 

be calculated. 

There are 3 different layout styles to choose from for Progressive Nesting. Each layout has 3 carrier 

conditions making a total of 9 possible options. 

One Up 

 
 
One Up Side Carrier 

 
One Up Double Side Carrier 

 

 
One Up Center Carrier 

 

 

Two Up 

 
Two Up Center Carrier 

 
Two Up Nested Carrier 

 
Two Up Double Side Carrier 
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Mirror 

 
Mirror Center Carrier 

 
Mirror Nested Carrier 

 
Mirror Double Side Carrier 
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Layout Parameters 

You can also specify the Distance Between Blanks, Blank to Coil Edge Distance, Carrier 
Width and Carrier to Part Distance parameters.  

The Distance Between Blanks is the minimum distance between the nested blanks.  

The Blank to Coil Edge Distance is the minimum distance between the nested blanks and the 
edge of the coil. This parameter is only used when there is no side carrier at the edge of the 
coil.  

Carrier Width determines the width of the carrier strip that is created in the layout.  

Carrier to Part Distance is the minimum distance between carrier and nested blanks. This 
value is often used to ensure that sufficient space is allowed for stretch webs and other 
attachment geometry. 

 

By selecting Create Attachment Surfaces, the nested layout will be constructed with surfaces 
connecting the carrier strip to the nested blanks. The location of these connection surfaces 
cannot be controlled by the user so they should be considered to be for visualization only. 

You can also specify the number of stations/blanks that you would like to have for the 
progressive nest layout.  Simply enter the number of stations in the Number of Stations field. 
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Layout Angle Constraints 

The Layout Angle determines the orientation of the blank on the coil. ProgNest will initially be 
set to Automatic and generate a table with all blank orientations that fall within the constraints.  

For a specific range of rotation angles select Variable Layout Angle. Input both the minimum 
and maximum angle while also selecting the increment angle to adjust the number of cases 
generated in the table. Results will contain all of the specified increment values as well as 
additional solutions between the specified increments. 

To create a solution with a specific rotation angle, choose Fixed Layout Angle. Input the 
desired angle into the dialog box. If the angle conflicts with any given constraints then the 
analysis will fail and a ProgNest error will occur. 

You can also define a line as a feed vector; this line will be used as the basis for the angles 
specified in the various constraint parameters. For example, if you want the blanks to be 
oriented such that a specific line will be lined up with the length of the coil, select the line as the 
feed vector and set a fixed layout angle of zero degrees.  

 

NOTE: The feed vector line must be in plane with the blank. 
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Width Constraints 

The Width refers to the width of the coil. ProgNest will initially be set to Variable Width with a 
minimum width of zero (no minimum) and a maximum width of 1828.8mm (72 inches) which is 
typically the widest coil that can be purchased.  

The Automatic option will not restrict the solution. 

To restrict the solution to a specific coil width, choose Fixed Width. Input the desired width into 
the dialog box. If the width conflicts with any given constraints or is too small to carry the blank 
then the analysis will fail and a ProgNest error will occur. 
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Progression Constraints 

Progression is a term used to describe the distance from one part to the next in a progressive 
die. ProgNest will initially be set to Automatic and generate a table with all solutions that fall 
within the other constraints.  

For a specific maximum of progression select Max. Progression. Input the largest allowable 
progression between two blanks. 

To restrict the solution to a specific progression, choose Fix Progression. Input the desired 
progression into the dialog box. If the progression conflicts with any given constraints or forces 
the blanks to overlap each other then the analysis will fail and a ProgNest error will occur. 
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Relative Angle Constraints 

The Relative Angle only affects mirror layouts. It refers to the angle between the original blank 
and its mirror. ProgNest will initially be set to Automatic and will generate a table with all the 
solutions that satisfy the other constraints.  

For a specific range of relative angles select Variable Relative Angle. Input the minimum and 
maximum relative angles as well as the desired increment. Results will contain all of the 
specified increment values as well as additional solutions between the specified increments. 

To restrict the solution to a specific relative angle, choose Fix Relative Angle. Input the desired 
angle between the blank and its mirror into the dialog box. If the relative angle conflicts with any 
given constraints or forces the blanks to overlap on each other then the analysis will fail and a 
ProgNest error will occur. 
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Viewing ProgNest Layout Results 

Once the ProgNest layout calculation is complete, the layout with the highest material utilization 
will be displayed on the X-Y plane and the corresponding result parameters will be listed under 
the FTIProgNest.1 branch. 

 

MatUtilization – (material utilization) % of the material that is used by the blank (as opposed to 
scrap) 

Pitch: calculated distance from one blank to the next blank in the layout (also the distance that 
the coil would be advanced after each press stroke) 

Width: calculated coil width 

BlankingCost: represents the cost of each blank based on the Base Material Cost, Extra 
Material Cost, Scrap Value, Consumables. 

  



FTICATIA V5: User Guide 109 
 

Copyright © 2022 Hexagon AB and/or its subsidiaries. All rights reserved. 

 

Viewing Other ProgNest Layout Results 

Additional layout results can be viewed in the Results Table. To open the Results Table, right 
click on the FTIProgNest.1 branch and select Table Results. 

 

To view other layout results, double click on the row for that result in the Results Table.  

<Line#> is the currently displayed layout. Columns can be sorted by selecting the column 
header.  

Pressing the button with the Excel icon on it will export the contents of the results table as a csv 
file and open them in Excel. 
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ProgNest Reports 

When the result is highlighted in the table results, the Report button will become active.  Select 
Report, choose the format of the report, either HTML or Excel based, name the report and 
select Save. 

The report will automatically open once created.  When selecting the Excel based report you 
may need to enable the macros to view all the data, or reduce your security settings in Excel. 

 

NOTE: In order to show images on the HTML report, you must turn on Activate local 
visualization on the General tab under Tools-Options-Infrastructure-Part Infrastructure. 
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Edge Displacement 

Check the edge displacement button to display the edge displacement of the part to the blank (shown 

below). 

 

Carrier Condition 

Check the carrier condition button to display a colored contour around the perimeter of the blank 
displaying whether or not that area is a good edge for a carrier.  A green boundary represents 
an area where a solid carrier or trim flange should be used, a blue boundary represents a 
stretch web or trim flange, and a red boundary represents a difficult carrier condition. 
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Editing Parameters 

To change the parameters of the progressive nesting layout double click a parameter from the 
ProgNest feature tree and enter the new value into the dialog box. Only input parameters can 
be changed from the feature tree. These include Carrier to Part Distance, Carrier Width, 
Distance between Blanks, and Blank To Coil Edge. The other parameters are results of the 
nesting calculation and can be referred to when creating formulae in CATIA. 
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Chapter 8: Cost Optimization 

In this section: 

▪ Introduction  

▪ Layout Editing 

▪ Cost Optimization 
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Introduction 

After nesting a blank, you can improve the material utilization of the nest layout by moving the 
blanks closer together such that they overlap. 

Cost Optimizer will then show you where you would have to modify the part geometry in order to 
realize the material savings. 

The resulting modified part edge and blank boundary can be used as a guide for modifying the 
part design in CATIA. 
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Layout Editing 

The nesting layout can be manually manipulated to test any changes or adjustments to the 
automatically generated nest.  Using this feature, changes in blank shape and its effects on 
nesting results can be tested by overlapping the blanks.  

To optimize the blank, right click on the FTIBlankNesting.1 branch and select Layout Editing. 
The Layout Editing dialog box will open. There are three areas in the Layout Editing dialog box: 
Cluster To Be Edited, Edit Blanks and Edit Coil Edges.  

For One Up layouts the Cluster To Be Edited area is not displayed in the Layout Editing dialog 
box. 

 

Cluster To Be Edited 

Side: When side is chosen, the two blanks on the right will be moved as a group.   

Top: When top is chosen, the blanks on the top will be moved as a group.   

Bottom: When bottom is chosen, the blanks on the bottom will be moved as a group. 

Edit Blanks 

Translation: The blanks can be moved right or left (+/- X direction) by defining an increment of 
movement and selecting the –X and +X buttons. The blanks can be moved up or down (+/- Y 
direction) by defining an increment of movement and selecting the –Y and +Y buttons. The +Y/-
Y buttons are not visible if the side cluster has been selected. 

Rotation: The blanks can be rotated in the counterclockwise (ccw) or clockwise (cw) direction 
by choosing the increment of rotation (degrees) and selecting the appropriate button.  
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Edit Coil Edges 

The top and/or bottom coil edge can be moved up or down (+/- Y direction) by defining an 
increment of movement and selecting the –Y and +Y buttons. If both the top and bottom coil 
edges are selected the +/-Y and -/+Y buttons will be available to move the coil edges at the 
same time in opposite directions. 

Notes: Clicking on the Reset button will return the blanks to the original nest. The parameters 
under the FTIBlankNesting.1 branch associatively update as the nesting layout is modified in 
the Layout Editing dialog box. 
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Cost Optimization 

Using the Layout Editing tools to overlap adjacent blanks or overlap the coil edge and blank 
edge (see chapter on Layout Editing) will result in an updated outline on the part geometry. 

The parameters under the FTIBlankNesting.1 branch will also associatively update as the 
nesting layout is modified in the Layout Editing dialog box. 
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Chapter 9: Trim Line Development 

In this section: 

▪ Introduction 

▪ Model preparation 

▪ Calculating the trim line by means of the function flange unfolding (Trim Line Development) 
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Introduction 

FTI TLD for CATIA V5.3 allows to unfold the flange, in order to, e.g. to derive a blank geometry 
based on the corresponding drawing geometry. The flange unfolding in FTI TLD is carried out 
by a finite element analysis and it takes the mechanical features and the displacement of the 
neutral axis due to the bending procedure into account. 

 

The flanges to be unfolded are shown in red 

 

The unfolded flanges are shown in blue 

Furthermore, FTI TLD for CATIA contains tools for an automatic determination of a drawing 
direction, for the calculation of trimming angles and for the determination and evaluation of a 
cam direction. The respective functions are described in detail in the following sections. 
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Model preparation 

As already mentioned, the mechanical features of the applied material are taken into account 
concerning the calculation of the unfolding of the flanges / trimming line. Since the material data 
provided by CATIA do not contain the necessary material features to perform these calculations, 
FTI refers to its provided material library in Tools / Options / Infra¬structure / Material 
Library. 

After selecting the corresponding material library (installation directory / FTICATIAV5RXX / 
FTICatalog.CATMaterial), a list of materials is provided. To assign a material to a part, the user 
needs to click on the Apply Material symbol in the lower toolbar. 

 

In the dialog box a material can be selected from the preset list and applied to the part. This 
assignation occurs by selecting the first entry of the structure tree, therefore , the whole part is 
selected. This procedure should be preferred because thus, the application of the material is 
clearly shown evident at the lower end of the structure tree. Alternatively, the flange / s can be 
selected separately. 

Since the sheet metal thickness has a direct impact on the longitudinal expansion of the flange 
during the unfolding process, it is furthermore necessary to define the applied sheet metal 
material’s thickness. Therefore, different possibilities exist: 

▪ At the Generative Shape Design (GSD) Workbench in Tools / Thin Parts Attribute Definition 

or 

▪ At the Part Design Workbench in Thick Surface or Shell Entit. 

Within the different functions of FTI TLD a punch direction (Press Direction) needs to be often 
defined. This may be achieved in various ways: 

▪ Selecting an already existing line 

▪ Selecting a plane surface. In this case, the direction of punch movement is considered as 

perpendicular direction.  

▪ Selecting a coordinate system. The z-axis is considered as the direction of punch movement. 

Furthermore, the flange needs to present a separate geometry. If the flange is part of the part, it 
first needs to be disconnected from the remaining part geometry. The easiest way is to use the 
Split function. For that the dividing line between the part and the flange needs to be selected 
within the Multiple Extract function (in the Dropdown of the Boundary function). Following this, 
the flange can be divided from the part (tip: By using the option “Keep Both Sides” the part and 
the flange stay visible and are available for next steps). 

Symbols and icons in this step in the Generative Shape Design (GSD): 

▪ Boundary function  

▪ Multiple Extract function  
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▪ Split function  

The unfolding of the flange is based on the by FTI developed solver technology and takes the 
displacement of the neutral axis during the forming process into account. Since FTI TLD is a 
construction assisting application, it does not provide any possibilities to illustrate metal forming 
phenomenon like thinning or stretching in the sheet metal’s upper or lower side. Moreover, all 
steps required for the finite elements analysis (meshing, setting up boundary conditions, etc.) 
are automated and run in the background. 
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Smoothing the trim line  

(Smooth Curve)  

By means of “Smooth Curve“, a smoothing of the determined curve is possible. By clicking on 
the icon “Smooth Curve“   in the “Trim Line Development“ toolbar, the curve is smoothened. 

 

The settings are: 

▪ Curve enables to select a line / curve which should be smoothened. If it is a 3D-curve, then it 

can only be smoothened by the B-spline option. If the trim curve is projected in advance by 

the function “Projection“   from a 3D-polyline to a 2D-polyline , i. e. to the tool layer (XY 

Plane),  then, besides the B-spline option, additionally, there are lines, or lines and circular 

arcs available. 

▪ Smooth Parameters: enable to take settings concerning the smoothing of the trim line. The 

black points on the trim line indicate the transition from one element to another (e. g. from 

a line to a circular arc). 

o Type: Here, the composition of the trim line is defined. It may consist of 3D-polylines 

(so-called Basis-splines (Bspline)), lines (lines), or lines and circular arcs (Lines & Arcs). 

o Tolerance +:describes the positively tolerated deviation of the smoothened trim line 

from the original trim line in x- and y-direction. 

o Tolerance – :describes the negatively tolerated deviation of the smoothened trim line 

from the original trim line in x- and y-direction. 

o Min. Arc Radius: defines the minimal radius of the used circular arcs. 

o Max. Angle: specifies the maximum angle between two elements of the trim line. 

▪ Create Feature: the selection of this option enables after closing by OK the generation of an 

entry of the dialog box ‘Smooth Curve‘ in the tree structure (‘FTIBlankFace‘). Hence, changes 

concerning the dialog box, or the trim line, respectively, may be done afterwards. Without 

the selection of this option, by closing by OK only a curve (Curve) of the smoothened trim 

line is deposited in the tree structure. 
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Appendix A – Editing the Materials Database 

In this section: 

▪ Editing the FTI Database  

▪ Editing the CATMaterial File 
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Editing the FTI Database 

1. Go to C:\FTI\FTICATIAV5Rxx\dat\matdbeditor 

2. Run FTIMaterialDatabase.exe to open the dialog below. 
 

 

3. Select Edit Material Database to open the Material Database interface shown below. 
 

 

4. To create a new material select the New button, then enter the required data and then 
Save the newly created material.   

5. If a user defined Stress Strain Curve (SSC) is available, it may be loaded into 
FTICATIAV5. 
 
Select a material from the list to add the SSC to, click the Mechanical tab and select the 
User Defined Curve button, and then select the Import button. 
 
In the Open dialog window, browse to the folder that contains the stress strain curve file 
and click Open. 
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NOTE: The stress-strain curve files are text files (.txt) with the extensions renamed to 
.ssc.  The format of the files is two columns, with strain in the first and stress in the 
second.  The values should be separated by a space.  A valid curve will be 
monotonically increasing when viewed as true stress/true strain. Noise in measured 
values and drop off at failure should be removed from the data set. 
 
When you open the stress-strain curve data you will be prompted to define the units 
used in your stress-strain curve.  Use the drop down menus to select the strain type, 
strain units, stress units and stress type.  Click OK to load the data. 
 
After defining the units and clicking OK to load the data, a graph illustrating the stress 
strain curve will automatically open. 
 
After viewing the curve close this image and click the Save button. 
 
You can also click Edit to modify the Stress-Strain curve. 
 

6. If a user defined Forming Limit Curve (FLC) is available, it may be loaded into 
FTICATIAV5.  This will override the FLD0 value.  
 
Select a material from the list to add a FLC to, click the Forming Limit Diagram tab and 
select the User Defined Curve button and select the Import button. 
 
In the Open dialog window, browse to the folder that contains the forming limit curve file 
and click Open. 
 
When you open the forming limit curve data you will be prompted to define the units 
used in your forming limit curve.  Use the drop down menus to select the strain type and 
strain units.  Click OK to load the data. 
 
After defining the units and clicking OK to load the data, a graph illustrating the forming 
limit curve will automatically open. 
 
After viewing the curve close this image and click the Save button. 
 
You can also click Edit to modify the Forming Limit Curve. 
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Adding the New Material to the FTICatalog.CATMaterial File 

Open the FTICatalog.CATMaterial file in CATIAV5 (C:\FTI\FTICATIAV5Rxx). It can be opened in the same 

manner as a CATPart file. The easiest way to create a new material is to copy an old one and then edit 

the properties and name: 

1. Copy one of the existing materials and paste it into the material set 

2. Rename the new material with the required name (it is case sensitive and must match 
the name of the material in the fti database perfectly) 

3. Edit the material properties; right-click on the material and edit the definition of the 
properties under the Analysis tab. In most cases, the material properties will be taken 
from the fti database (as opposed to the CATMaterial file), however the density will be 
used by CATNest and ProgNest for blank weight calculations. 
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